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1. FOLDER ORGANIZATION
1.1. Template / WDIR structure

1.2. WORKING DIRECTORY PATH

1.2. Single folder structure

1.3. Eureka tool database

1.4. Documents / Setup / Backup
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1.1. TEMPLATE / WDIR STRUCTURE

TEMPLATE: folder containing the reference files,
where starting the configuration of the new project.

(Write protected to prevent changes).

WDIR: folder containing 3D models, macros and
scripts of the installed robot cells.

(Important: do not modify the content so as not to
compromise the configuration of the robot cells).

PROJECTS: folder containing the saved «*.epf»
projects, starting from the «Template» file.

PROS: Better long-term management, above all with
more robot cells.

CONS: Learning the "WDIR Path" configuration
procedure (following page).
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This path will indicate to the Eureka template or project file, where the files that set up the virtual machine are 
located.

• Double-click on Eureka 10 icon to open an empty project.

• "View" menu > "Options".

• Click with the left mouse button on the path search icon and indicate the inside of the "WDIR" folder, 
described in the previous page.

5

1.2. WORKING DIRECTORY PATH (WDIR) 



1.3. SINGLE FOLDER STRUCTURE

ROBOT_01 folder containing:

Template: reference file, where starting for the
configuration of the new project.

WDIR: folder containing 3D models, macros and
scripts of the installed robot cells.

PROJECTS: folder containing the saved «*.epf»
projects, starting from the «Template» file.

PRO: Possibility to move folders, without affecting
the template file.

CONS: The accumulation of material inside this
structure makes difficult technical support
operations.
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1.4. DOCUMENTS / SETUP / BACKUP

Depending on the needs, there may be other folders,
containing manuals, installation files and a backup
folder, where the versions of the delivered robot cells
or the backups created to request technical support
are stored.

TICKET AND TECHNICAL SUPPORT:

• «File> Save backup» to generate a compressed
folder containing all the information on the
project currently open in Eureka.

• Send an email to "heldpdesk@roboris.it"

• The subject of the email will be the title of
the ticket.

• Attach a backup of the processing to the
email.

• The body of the email will represent the
description of the ticket.
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2. NEW PROJECT
2.1. Opening and saving a new project

2.2. File storage
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Opening a new project:

• Double-click the template file («*.epf» or «*.ept») of the machine you want to use or open Eureka, then click on 
«File > Open Project» and select the model file of the robot/machine you want to use.

• Check for any error or warning messages (message window) at the start.

Saving a new project:

• "File > Save project as ..." to create a new project («*.epf»), inside the PROJECTS folder.

(Use "File > Save project" only to overwrite an old project)
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2.1. OPENING AND SAVING A NEW PROJECT



2.2. FILE STORAGE

Before starting to load any type of element into the 
new project, it is necessary to properly storage all 
the files necessary for the simulation:

• Workpiece(s)

• Fixture(s)

• Program(s)

• Tool(s)

Once the files have been copied, inside the project 
folder, you can proceed to upload them to Eureka.

3D models: the «*.stl» format is preferable.

Thanks to external importers, it will be possible to 
import most of the files from CAD software (example: 
IGES; WRML, etc...).

Program: any file editable with a text editor.
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2.2. FILE STORAGEE

TOOL_DATABASE: folder containing the tools 
available within Eureka.

• 3D_MODELS: Folder containing the 3D models 
used for configuring the tools.

• «*.ETF» (Eureka tool file): file containing tool 
informations.

The database can be also shared between two 
or more projects.

Possibility of having multiple databases.
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3. WINDOW ARRANGEMENT
3.1. Main windows

3.2. Main toolbar

3.3. Message bar

3.4. Controller bar

3.5. Kinematics structure bar

3.6. Machine setup bar

3.7. Navigator Commands

12



3.1. MAIN WINDOWS

Click on «View» and check the following items:

• Main Toolbar

• Message bar

• Controller bar

• Simulation bar

• Kinematics structure bar

• Machine setup bar

• Function bar

Drag the title bar of the listed windows to view
the anchor points.

Move the mouse over the anchor point to constrain
the window and compose your work environment.

At any time, it will be possible to detach the windows
and change their arrangement.
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3.2. MAIN TOOLBAR
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«New»: open a void template.

«Open»: open an existing project.

«Save»: save the current
opened project.

«Enable/Disable collision
detection»: green check
symbol for "enable".

«Show/Hide toolpath traces»:
show/hide tool trajectory during
the simulation. Green check
symbol for "show".

«Show/Hide...»:
show/hide toolbar as in View
menu. Green check symbol for
"show".



Show a report of the simulation status.

«Message info»: informations about the machining.

«Warning»: non-critical message (missing subprograms, collision detection disabled, etc…).

«Error»: critical error (out of limits, collisions, syntax error).

Double-click any message to view the APT program line that generated it.

15

3.3. MESSAGE BAR



3.4. CONTOLLER BAR
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«Show the program window»:
open the program editor
window.

«Tools Database»: open the
current tool library window to
add/edit/remove tools to the
current project.

«Macro list»: open the macro
list window to add/edit/
remove subprograms to the
robot cell.

«JOG»: open the JOG
window to manipulate
robot position.

«Load program»: load the
APT program file in the
current project.

«Save postprocessor output»:
at the end of the simulation
allow, if there are no errors, to
generate the robot program.



3.5. KINEMATICS STRUCTURE BAR

The kinematics structure bar shows only all the 
nodes that make up the robot cell in Eureka.

• Robot cell

• Axis node

• Robot Frames

• Tools node

• Workpiece

• Fixture

Standard users should not modify the kinematics 
structure.
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3.6. MACHINE SETUP BAR

The machine setup bar shows only the nodes that 
the standard Eureka user can modify.

• Program

• Playlist

• Subprograms

• OBJECTFRAME list

• TOOLFRAME list

• Tools

• Workpiece

• Fixture

In the early stages of configuration, it is advisable to 
keep this window superimposed.
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3.7. NAVIGATION COMMANDS

In the 3D view, you can switch from "Selection" 
mode to "Navigation" mode by clicking the right 
mouse button.

• SELECTION: allows you to select elements and 
acquire vertices on the mesh (path measurement 
or capture commands).

• NAVIGATION: Rotate, translate, zoom in/out.

CUSTOMIZE NAVIGATION COMMANDS:

• «View > Options»

• "3D Navigation" window

• Create a new profile and change the available 
actions, to customize navigation in Eureka.
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4. ROBOT CELL SETUP
4.1. Program

4.2. Subprograms

4.3. Tool database path

4.4. Tool database

4.5. Workpiece

4.6. Fixture

4.7. 3D model import options
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4.1. PROGRAM

Make sure you have clicked on the "Terminate simulation" button.

• Right click on "Program".

• "Modify”.

• Select the APT file you want to use as the main 
program.

• When the upload is complete, the program 
window will appear.

The program window allows you to edit the 
previously loaded file, using many of the features 
commonly found in text editors (copy, paste, cut, 
find/replace and other).

As the other toolbar it is possible drag the program 
window by the title bar to the working enviroment.
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4.2. SUBPROGRAMS

Make sure you have clicked on the "Terminate simulation" button.

• Right click on "Subprograms".

• "Modify".

• "Add" command to load a specific macro or 
subroutine for the project used.

• The latter will be shown in the list of available 
macros / subroutines.

In the program window, click on "File" to see the 
contents of the available macros.

In case of new macros, used for any future project, it 
will be necessary to contact your technical reference 
to modify the template file of the machine.
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This path will indicate to the Eureka template or project, where the folder containing the virtual tools is located.

• Double-click the template file («*.epf» or «*.ept») and open one of the available machines.

• “Right click > Properties" on the robot node, in the kinematics window.

• Choose the "Tool Library" page and click the search icon. Indicates the inside of the "TOOL_DATABASE" 
folder.

• At the end of this operation the tool library icon will be enabled.
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4.3. TOOL DATABASE PATH



• Right click on "Tools".

• "Modify".

The geometry of the cutting and non-cutting parts can be recreated in Eureka, thanks to parametric shapes 
and/or «*.stl» models.

(In terms of performance, parametric shapes return the best result)
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4.4. TOOL DATABASE



Check the document «Eureka10_TOOL_DATABASE_eng» for further information on the creation of 
parametric tools, from 2D profiles, 3D models or revolve and extrusion.
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4.4. TOOL DATABASE



4.5. WORKPIECE

Make sure you have clicked on the "Terminate simulation" button.

• Left-click on "WORKPIECE".

• Right-click in the window under the "Machine 
setup bar" (yellow window).

• "Add > Shape from file" to load a 3D model 
(preferably in «*.stl» format) previously exported 
from CAD or CAM.

or

• "Add" and select one of the available parametric 
shapes.

PROPERTIES OF THE LOADED 3D MODEL:

• Right-click on the name of the newly imported 
shape
• "Select as stock": once you click on 

"Restart", the graphic shape will be 
converted into a stock model on which to 
remove the material.

• "Properties": the properties window will be 
displayed to modify the position, scale, 
color and transparency of the 3D model.
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4.6. FIXTURE

Make sure you have clicked on the "Terminate simulation" button.

• Left-click on "FIXTURE".

• Right-click in the window under the "Machine 
setup bar" (yellow window)

• "Add > Shape from file", to load a 3D model 
(preferably in «*.stl» format) previously exported 
from CAD / CAM.

or

• "Add" and select one of the available parametric 
shapes.

PROPERTIES OF THE LOADED 3D MODEL:

• Right-click on the name of the new shape

• "Property"

The properties window will be displayed, to change 
the position, scale, color and transparency of the 3D 
model.
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4.7. 3D MODEL IMPORT OPTIONS

Following the commands "Add> Shape from file", 
Eureka will show a 3D model search window (default 
format: «*.stl»).

Reference: reference on which the 3D model will be 
placed, in Eureka

• Parent: The 3D model will be positioned with 
respect to the coodinate system of the 
"WORKPIECE" node.

• Machine / Subsystem: the 3D model will be 
imported with respect to the coodinate system 
of the "ROBOT" node (machine name).

To identify the coodinate system of the "WORKPIECE" or 
"ROBOT" node:

• "View > Kinematic Structure".

• Click on the node “WORKPIECE" or "ROBOT" (machine 
name).

• In the 3D window, locate the highlighted coordinate 
system.
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5. MACHINING PARAMETERS
5.1. Linear/Angular precision

5.2. Collision tollerances

5.3. Machining quality

5.4. Stock window
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5.1. LINEAR/ANGULAR PRECISION

These two parameters indicate, every how many 
millimeters or degrees, Eureka performs a collision 
check, rapid removal and other possible errors.

• "Settings" menu

• “Machining parameters"

Increasing these values will greatly increase the 
simulation speed reducing the accuracy.

By default, these two parameters will have a value of 
1 but for large workpieces is possible to use 3, 5, 7, 
up to a maximum of 10.
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5.2. COLLISION TOLLERANCES

These parameters indicate how accurate the 
software will be in detecting possible material 
removal in rapid errors or collisions between the tool 
parts and the workpiece.

• "Tollerance for material removal during rapid 
movements": limit beyond the tool can pass 
through the part, moving at rapid speed, without 
generating the “Material removal in rapid" 
message.

• "Configure tool/workpiece interference check"

• "Allowed interference": limit beyond the tool 
can cross the reference piece, before 
generating a "Collision" message.

• “Near miss": the maximum distance the 3D 
model of the tool can approach the part, 
before generating a message of "Collision or 
close to collision ..."
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Indicate the simulation mode in Material removal:

• Hi-Accuracy: optimized simulation for milling applications, more accurate collisions evaluation and stock calculation.

• Hi-Speed: standard simulation mode.

• Hybrid: mandatory for additive/hybrid applications.

Drag the "Visualization quality vs performance" bar to increase or decrease the graphic quality of the machined piece. 
More quality takes slower graphic simulation. 

(Be careful: in Hybrid mode it is not possible move the bar during simulation)
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5.4. STOCK WINDOW

Click the icon to display the "Stock window".

Respect to the 3D view, stock window show only the 
model to be machined, the tool used and the fixture 
with the best graphic quality available (depending on 
the resolution of the window).

It will be possible to decrease the quality of the 
machined piece in the "Machining parameters" menu 
to increase the speed and keep the "Stock window" 
superimposed to have a high detail for material 
removal.

The three illuminated green circles indicate the best 
quality available.
Deselect one or more green circles to decrease the 
graphic quality.
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6. SIMULATION
6.1. Collision check

6.2. Toolpath trace

6.3. Error/Warning management

6.4. Quick check

6.5. Pre-analysis

6.6. Simulation commands

6.7. Simulate by the program window

6.8. Breakpoints

6.9. «Snapshot»

6.10. Stock detail view

6.11. JOG
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• Click on the "Enable/Disable collision detection" icon.

Eureka will check for collisions on all the parts of the machine.

To exclude a 3D model, from checking, it is necessary

• Switch to "Selection" mode and left-click on the 3D model in the 3D window.

• "Disable collision detection".
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6.1. COLLISION CHECK



• Click the “Show/Hide toolpath trace" icon to show/hide the trajectory of the active tool.

CHANGE THE COLOR OF THE TOOL TRACE:

• "Settings" menu

• “Toolpath traces”
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6.2. TOOLPATH TRACE



6.3. ERROR/WARNING MANAGEMENT

For each type of error or warning it will be possible 
to decide what Eureka's behavior will be.

• "Settings" menu

• "Error/warning settings"

Select:

• "Continue": Eureka will show the message in the 
message bar, but the simulation will continue.

• "Pause": Eureka will show the message in 
the message bar and the simulation will be 
stopped, showing the line of the program where
the error or warning occurred.

• "Ignore": Eureka will not show the error and the 
simulation will continue without messages.

Without some modules, other than the standard one, some of 
the items in the figure may not be present.
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6.4. SIMULATION COMMANDS
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«Quick check»: quickly analyzes 
the APT program and shows 
possible syntax problems or 
missing elements (example: 
missing macro or tool).

«Restart»: restores the 
stock model and restores the 
simulation to its initial state.

«Terminate simulation»: stops 
the simulation and allow to 
import new 3D models, new 
programs or perform some 
operations.

«Simulate all» (F5): starts the 
simulation of the APT program, 
which shows both the 
movements of the robot and 
the material updating (if there 
is a stock model).

«Simulate without 3D display»: starts the 
simulation of the iso program in hidden mode, 
without showing the movements of the robot or 
the material updating. The results will be 
displayed once the simulation is stopped.



6.5. QUICK CHECK

Make sure you have clicked on the "Terminate simulation" button.

• Click on the "Quick check" button.

• Eureka will perform a quick check of the 
imported APT program and return a report, in the 
form of messages (errors / warnings).

This check does not include the detection of any 
collisions but aims to identify syntax errors, missing 
macros and errors related to programming.
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6.6. PRE-ANALYSIS

Make sure you have clicked on the "Terminate simulation" button.

• Click on the "Pre-analysis" icon.

• "Restart".

Eureka will start a thorough analysis of the imported 
APT program.

Once the pre-analysis is finished, by clicking on the 
"Simulate without display" icon, Eureka will show us:

• Time spent in the simulation.

• Estimated simulation time.

• Remaining time to complete the simulation.

Check the message bar to detect the “Simulation” 
option and switch to “Pre-analysis”.

Eureka will show the pre-analysis result.
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6.7. SIMULATE BY THE PROGRAM WINDOW
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«Simulate all» (F5): 
starts the simulation of 
the APT program, 
which shows both the 
movements of the 
robot and the material 
updating (if there is a 
stock model).

«Simulate line»: line-by-line 
simulation, including the 
content of subroutines and 
macros.

«Simulate line/procedure»(F11): 
the simulation will stop at each 
new line of the program, 
showing the results. In the 
presence of macros or 
subroutines, Eureka will execute 
the entire content, without 
showing it.

«Simulate procedure»: allows 
to execute the contents of a 
macro or subroutine and return 
to the height of the main 
program.



6.8. BREAKPOINTS

The "Breakpoints" allow to automatically stop the 
simulation when a certain line is reached or by 
indicating a certain condition.
(example: identification of a series of letters and 
numbers)

• Make sure the green check mark is present on 
the "Ignore Breakpoint" icon.

• Click on the side of the program to add a new 
breakpoint.

• Click on the "Breakpoints" menu to open the 
breakpoint window and define a new condition.
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6.9. SNAPSHOT

With the "Snapshot" it will be possible to save the 
simulation state so that it can be restored in case of 
Eureka closure or work interruption.

• "Restart".

• Fully or partially simulate the APT program.

• Click on the "Create simulation snapshot" icon.

• Define the name for the new snapshot and/or 
click «Ok» to confirm the command.

RESTORE SIMULATION SNAPSHOT:

• Click "Restore simulation snapshot".

• Choose one of the available snapshots from the 
list.

• Confirm with "Ok".
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6.10. STOCK DETAIL VIEW

This command allows to analyze a portion of the 
stock model, concentrating the graphic resources in 
a limited area.

• Make sure you have one or more stock models.

• Switch to "Selection" mode and left-click on the 
3D model of the stock.

• “Stock detail view".

• Place the cursor on the stock model and select 
the vertex from which to expand the detail area 
(cube).

• Roll the mouse wheel forward to enlarge the 
detail area.

• Left click on the 3D view to confirm the 
command.

A small selection has more details.
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6.11. JOG

Make sure you have activated the simulation.

The "JOG" allows to check/move the axes positions.

For cartesian movements:

• Indicate the toolframe that should be moved.

• Indicate the reference objectframe.

• Indicate a "Step" and click on "+/-" on "X,Y,Z" to 
translate and on "RX,RY,RZ" to rotate in positive 
and negative direction respect to the selected 
reference frame axes (TOOL, BASE, 
WORLD, OBJECT).

For axes movements:

• Indicate a "Step" and click on "+/-" to move the 
axes in positive and negative direction.
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7. PROGRAM EDITOR
7.1. Edit The Apt Program

7.2. Insert/Replace As/ Insert Call To Macro

7.3. Set Next Line / Restart From Here

7.4. Insert File / Insert Or Remove Brekpoints

7.5. Set Tool Direction

7.6. Capture Toolpath

7.7. Approach

7.8. Zrot

7.9. External Axis Position

7.10. External Axis Interpolation

7.11. Goto Strategy

7.12.Rotate/Translate

7.13. Line / Arc Fitting

7.14. Interpolate Tool Direction/ Tanprep/ Convert Arcs

7.15. Split/ Reverse / Mirror

7.16. Syntax Coloring

7.17. Tool Calls
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7.1. EDIT THE APT PROGRAM

The program window integrates a text editor, with
the possibility of:

• Program manually, even starting from an empty
file typing on the text.

• Cut/Copy/paste portions of the program.

• Comment out multiple lines of code at the same
time.
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7.2. INSERT/REPLACE AS/ INSERT CALL 
TO MACRO

Right-click on a single line in the program

• "Insert": insert the current robot position in the APT

program as TOOLFRAME position respect to the

current work origin, or as joints position (MOVEJ).

• "Replace as": replace the selected line in the APT

program with the current robot position as

TOOLFRAME position respect to the current work

origin, or as joints position (MOVEJ).

• "Insert call to macro": insert the call to a macro from

the controller macro list before of the current

selected line the current APT.
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7.3. SET NEXT LINE / RESTART FROM 
HERE 

Right-click on a single line in the program

• "Set next line": the simulation will come back to the

selected line without re-simulating the APT program,

neither checking collision or updating the raw model.

• "Restart from here": the APT program will be re-

simulated from the beginning, without considering

collision checking. The simulation will automatically

stop on the selected line and the raw model will not

be updated.

• "Restart from here (update stock)": the APT program

will be re-simulated from the beginning. The

simulation will automatically stop on the selected

line and the raw model will be updated, considering

the changes made to the program.
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7.4. INSERT FILE / INSERT OR REMOVE 
BREKPOINTS

Right-click on a single line in the program

• "Insert file...": insert text lines from an external

file before the selected line in the APT program.

• "Insert/Remove breakpoint": insert or remove a

breakpoint in the selected line of the APT

program.

• "Remove all breakpoints": remove all breakpoints

in the program editor.
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7.5. SET TOOL DIRECTION

Modify the tool direction of the selected line(s) using
one of the following option.

• Set the tool direction along an axis of the current
work OBJECTFRAME (X, Y, Z, -X, -Y, -Z).

• Set the tool direction normal to a face.

• Set the tool direction selecting two points of a
segment.

• If more lines are selected, set the tool direction
of the first selected line in all the following
selected lines.

• Set the tool direction using two
angles referred to the current work OBJECT
FRAME.
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Right-click on a single line in the program

Insert movements lines before the selected line capturing the toolpath as polyline, arcs or a combination of both.

• Linear movements will be converted in GOTO commands.

• Arc movements will be converted in CIRCLE commands.

The tool direction is automatically set normal to the captured point plane.
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7.6. CAPTURE TOOLPATH



Right-click on a single line in the program

Choose the robot joints configuration and position to reach the selected point. Red value represents axis value.

1. Slide the bar to change the joints position in the current configuration.

2. «i/n» values represent the current i configuration on n configurations available for the selected point.

After this command, use "Insert/ Replace as" MOVEJ command to save the choosen approach in the APT program.

Changing the axis configuration is possible to solve some problems (mainly in on approach moves) as singularity, collision and others.
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7.7. APPROACH

1

2
JOINTS POSITION



7.8. ZROT

Right-click on a single line in the program

Rotate the robot wrist around TOOLFRAME Z
axis.

• Type the value in degrees or slide the bar
to select rotation angle.

• Click confirm to update automatically the
current selected line and save the change
in the APT program.

Rotating the robot writst around TOOLFRAME
Z axis is useful to solve singularity or collision

issues.
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7.9. EXTERNAL AXIS POSITION

Right-click on a single line in the program

Choose the external axis position to reach the
current selected point

• Set the axis that need to be changed on
combo list 1.

• Set the axis position value on text box 2 or
slide the controller 3.

After this command, use "Insert/ Replace as"
command (with external axis declared) to
save the choosen position in the APT
program.
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7.10. EXTERNAL AXIS 
INTERPOLATION
Right-click on a single line in the program

Set the external axis interpolation strategy.

• Select the intepolation strategy from the combo
list.

• Select the external axis that should be
interpolated.

• Set the strategy parameters.

• Press OK to confirm an insert the MODE/INTERP
command in the selected line.

If no interpolation strategy is choosen, the external
axis will remain constant at their initial position.
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7.10. EXTERNAL AXIS
INTERPOLATION
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1. OPTIMIZE_ROTARY_AXIS/MIN_XYZ

2. OPTIMIZE_TRACK/MIN_ROBOT_CHANGES

3. OPTIMIZE_ROTARY_AXIS/MIN_ORI

4. OPTIMIZE_TRACK/ALIGN_ROBOT_BASE

5. OPTIMIZE_TRACK/ALIGN_ROBOT_WRIST

6. OPTIMIZE_GANTRY

7. SPINNING_AXIS

8. OPTIMIZE_ROTARY_AXIS/ECCENTRIC_TURNING

9. OPTIMIZE_2-AXES_POSITIONER/UPDIR

10. OPTIMIZE_PART_SLIDER

11. OPTIMIZE_TRACK_ROTARY_AXIS/MIN_XYZ

12. OPTIMIZE_TRACK/ALIGN_ROBOT_BASE

_ROTARY_AXIS/MIN_ORI

13. OPTIMIZE_TRACK_ROTARY_AXIS/MIN_ORI
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7.11. GOTO STRATEGY

Right-click on a single line in the program

Set a strategy to orient the TOOLFRAME axis
direction for GOTO moves.

• Select the intepolation strategy from the list on
the left.

• Set the strategy parameters.

• Press OK to confirm an insert the
STRAT command in the selected line.

The default strategy is minimum rotation around the
TOOLFRAME Z axis (EEROT strategy with 0 angle).
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7.11. GOTO STRATEGY
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Rotation around Z

Minimum wrist rotation Pivot point

Tangent to the path Axis on plane



7.12.ROTATE/TRANSLATE

Right-click on multiple lines in the program

Apply to them one or more of the following
transformations.

• Translate:
Translate the selected lines along X, Y and Z axis
of the current work OBJECT FRAME or the
current TOOL FRAME is the flag is enabled.

• Rotate:
Rotate the selected lines around their tangent
(T-value) and normal (B-value) versors.

• Fade-in/Fade-out:
Set the distance from the begininng/the end of
the selected toolpath lines to define the range
where applies the previous trasformations.

Press Update to see the trasformations preview.

Press Ok to confirm the trasformations.
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7.13. LINE / ARC FITTING

Right-click on multiple lines in the program

Line fitting:

Simplify the selected lines on a new linear tollerence.

• Enter the linear tolerance in millimeters.

• Click on «Ok» to perform the calculation.

Arc fitting:

Simplify the selected lines on new arc tollerence.

• Enter the arc fitting parameters.

• Click on «Ok» to perform the calculation.
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7.14. INTERPOLATE TOOL DIRECTION/ 
TANPREP/ CONVERT ARCS
Right-click on multiple lines in the program

Interpolate tool direction:

Interpolate the tool direction of the selected
line(s) between the initial and the final tool direction.
Both tool directions angles can be modified.

Tanprep:

Split the movements in 2 parts to create an initial
short segment where the tangent GOTO strategy can
align correctly the TOOLFRAME orientation.

Convert arcs to polylines:

Converts arcs to polylines after the max chordal
error is set for the conversion.
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7.15. SPLIT/ REVERSE / MIRROR

Right-click on multiple lines in the program

Split:

Split the selected toolpath lines of a splitting step.

Reverse:

Revert in the toolpath the selected lines from the
last to the first one.

Mirror:

Mirror the selected lines respect a reference plane of
the work OBJECT FRAME.
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7.16. SYNTAX COLORING

• Click the "Settings" icon in the program window.

• "Enable syntax coloring".

• "Ok".

CHANGE THE COLOR OF THE SYNTAX:

• Click the "Settings" icon in the program window.

• "Syntax Colors".

• Click on «Syntax Colors» to modify the single 
rules associated with groups of numbers and/or 
letters.
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7.17. TOOL CALLS

• Click on the "Tool Calls" menu to view the list of 
all tools used up to that point by the simulated 
program.

• Right-click on one of the listed tools and select 
"Restart from here" or "Restart from here (update 
stock)“.

Then, the list can be printed by clicking on the 
relative icon.
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8. FUNCTIONS
8.1.Measures

8.2. Compare machined stock with finished

66



8.1. MEASURES

• "Functions" menu

• "Measures"

In the section on the left you can select the type of 
measurement:

• Distance

• Diameter

• Angle

• Position of a point with respect to an element of 
the kinematics.

In the right section you can select the filter for the 
selection:

• Summit

• Edge

• Face

• Center for three points
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8.1. MEASURES

MEASUREMENTS IN THE STOCK WINDOW:

• Click the “Stock Window" icon.

• "Functions > Measures"

• Choose the "Center of a circle" selection filter

• Place the cursor on the circumference of a circle 
or on the side of a cylinder.

Eureka will show the radius of the detected circle.
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8.1. MEASURES

The "Coordinate system" option is used to determine 
the position of a point.

• Select the type of measurement "Position of a 
point"

• Click the button to the right of "Coordinate 
system" to select a different reference system 
from which to take the distance.

• Click on the point you are interested to analyze.

• In the part below "Coordinate system" the 
obtained values will be shown.

69



8.2. COMPARE MACHINED STOCK 
WITH FINISHED

At any time during the simulation, without 
interrupting it, it will be possible to make a quick 
comparison between the machined stock and the 
finished part.

A color scale will help the user to identify areas 
where more material needs to be removed to 
achieve the desired result or areas where more 
material than necessary has been removed.

• Left click on the stock model.

or

• Click the "Compare machined blank to finished" 
icon.

• "Compare machined blank with finished".

• Click on the magic wand icon to specify how 
many layers the color scale will consist of and 
what the transition between them will be.

• Confirm to view the result.
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8.2. COMPARE MACHINED STOCK 
WITH FINISHED

Once the color scale and the step between one level 
and another have been configured, it will be possible 
to choose whether:

• Color the machined stock.

• Color the finished part.

or

• Create sections.

• Click «Ok» to view the result.

• Click on the 3D model to get the distance to the 
reference part.

Click on «Configure» to return to the configuration 
window and change the parameters of the 
comparison or to choose a different staining method.
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8.2. COMPARE MACHINED STOCK 
WITH FINISHED

Once the color scale and the step between one level 
and another have been configured, it will be possible 
to choose whether:

• Color the machined stock.

• Color the finished part.

or

• Create sections.

• Click "Ok" to view the result.

• Click on the 3D model to get the distance to the 
reference part.

Click on «Configure» to return to the configuration 
window and change the parameters of the 
comparison or to choose a different staining method.
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8.2. COMPARE MACHINED STOCK 
WITH FINISHED

COLOR SECTIONS:

• Choose "Color Sections".

• "Ok".

• In the "Section Settings" window you can specify 
the plane on which to make the section.

• Drag the blue bar, under «Distance (mm)», to 
position the plane used to generate the section.

• "Ok" to view the results.

Enter a number other than 1 in the "Number of 
sections" field and specify a step to generate multiple 
sections at the same time.
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